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Capitulo 15. EL MODELO LINEAL
GENERAL

En este capitulo se continla con el proceso de investigacion
econométrica. En el desarrollo del mismo, el investigador ya ha
aprehendido todas las etapas; tiene su problema a investigar, ha
planteado y completado su tabla de datos -luego de definir sus
fuentes de informacion y de recolectar los datos- y ha aplicado
métodos basicos de analisis de la informacién, tanto sobre las
unidades de observacién como sobre las variables involucradas en
su estudio. Es en este momento en el que debe especificar y
estimar un modelo econométrico, para establecer relaciones entre
variables y corroborar -en espacio y tiempo especifico- sus teorias
y modelos econdmicos. En este capitulo se muestran cuales son las
condiciones necesarias y los conocimientos -matematicos vy
estadisticos- suficientes que el investigador debe tener para poder

realizar dicha especificacion.
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15.1. Introduccion

En el Capitulo 1 de este manual, se definid econometria como: ...
la aplicacion de métodos matematicos y estadisticos a tablas de
datos, que contienen ‘“unidades” (de observaciéon) por
caracteristicas observables de las mismas (“variables”), con el
propdsito de dar contenido empirico a las teorias econdmicas
planteadas en modelos, verificandolas a partir del estudio de la
semejanza entre unidades y la relacion entre variables, en un

espacio y tiempo especifico.

Para lograr ese objetivo, se utiliza como instrumento basico un
modelo -denominado modelo lineal general- que es una
representacién simplificada del mundo real. Este modelo, para ser

operativo, ha de estar expresado en forma matematica.

Ejemplo 15.1 Si se desea estudiar el consumo familiar, en un
periodo de tiempo determinado (t), la teoria econdmica modela el

consumo en funcién de la renta, es decir:

C=f(R) con fr >0

Para poder trabajar con este modelo se supondrda una forma

funcional para f, por ejemplo una relacion lineal, que se escribira
como:
Ct=0(+,BRt, Vt=1,,T

Donde: a representa el consumo auténomo y g la propension
marginal a consumir que se supone comprendida en el intervalo
[0,1]
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En el modelo del ejemplo 15.1 se explica el consumo por medio de

una variable que determine el nivel de renta.

De acuerdo a esta especificacion, se consume -en un momento de
tiempo- una proporcién de la renta medida por BR,, la diferencia

entre ambas cifras se supone constante (a).

Este modelo de consumo se puede utilizar:

» A nivel agregado, en cuyo caso las variables C,y R, seran
indicadores del nivel de consumo y renta agregados, para lo
cual se requieren observaciones numéricas de las variables
durante un periodo de tiempo t. Por lo tanto, las
observaciones correspondientes a cada una de las variables

es una serie temporal.

A nivel desagregado, por ejemplo relacionando los gastos
semanales en consumo y los ingresos de las familias, las
observaciones correspondientes a cada una de las variables
es un dato obtenido de una muestra de un conjunto de

familias y se denominan datos de corte transversal.

« En forma conjunta, combinando las observaciones de una
muestra de corte transversal en el tiempo, esto se

denomina datos de panel.

Hay que tener en cuenta que, para realizar este estudio sobre el
consumo o cualquier otro que requiera la especificacién de un
modelo lineal general, se debera aplicar el proceso de investigacion
econométrica descrito a lo largo de los anteriores capitulos. Es
decir, se debera definir el problema a investigar -en este caso el

consumo-; se planteara una tabla de datos que contendra unidades
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de observacion temporales (estudio de series de tiempo),
individuos (corte transversal) o una combinacién de ambas (datos
de panel); se disefara la fuente de informacidn; se recolectara la
misma vy, finalmente, se podrda realizar la especificacion vy

estimacién del modelo propuesto.

Ejemplo 15.2 Si se desea estimar la funcidon de produccién de una
empresa, en un periodo de tiempo determinado (t), la teoria
econdmica modela la produccién como una funcion de los factores

trabajo y capital:
P=f(,K)
Donde
P, es la produccion, L es el factor trabajo y K el capital.

Si la funcion de produccién de la empresa es de la forma Cobb-

Douglas:
P, = ALZKP; vt=1,..,T

El valor de la suma a+pB va a determinar si la empresa tiene

rendimientos a escala constantes, crecientes o decrecientes.

Al realizar un trabajo econométrico, el primer paso es formular un
modelo que, aun siendo una representacién simplificada de la
realidad, permita reproducir los patrones de comportamiento entre
las variables econdmicas. Generalmente, la teoria econdmica no
suele dar muchas indicaciones de cual es la forma funcional del

modelo, por lo que han de realizarse supuestos al respecto.

El segundo paso es estimar los parametros de interés del modelo a
partir de los datos disponibles y contrastar aquellas hipdtesis

estadisticas y econdmicas que son relevantes.
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Ejemplo 15.3 Si se estimd una funcidn de produccién Cobb-
Douglas, puede interesar contrastar la hipdtesis de que la empresa

tiene rendimientos a escala constantes; es decir, que a + g = 1.

Por ultimo, el modelo econométrico estimado y validado, se puede
utilizar para predecir valores futuros de las variables o tomar

decisiones de politica econdmica.

Se recurre al andlisis de regresion para describir la relacidén
existente entre una variable enddgena o dependiente -de
argumento vectorial denominada y- y un conjunto de variables
exogenas, explicativas o independientes  -representadas

genéricamente por la matriz de regresores X-.

Estas relaciones pueden ser de caracter deterministas o
estocasticas. Las primeras son las utilizadas en los modelos de los
ejemplos anteriores; las segundas, como las del ejemplo 15.4,
tienen en cuenta factores aleatorios que influyen en el

comportamiento de los agentes econdmicos.

Ejemplo 15.4 El modelo de consumo supone que, dada una renta

R,, todas las familias (de un conjunto de n familias) con esa renta

presentan un mismo nivel de consumo, lo que es poco realista.

Para modelar este comportamiento individual se introduce un

término aleatorio, la perturbacion g;:

Ci=PB1+BRi+¢; Vi=1,...n
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Los parametros del modelo son los coeficientes B; y los que

caracterizan la funcidon de distribucién de la perturbacion aleatoria

vectorial g; es decir, su valor medio y su matriz de varianzas y

covarianzas. El conjunto de parametros a estimar da origen a lo que

se denomina un vector paramétrico: w = [; ¢Z|; Vj=1,...k

Asi, el modelo lineal general se puede estudiar siguiendo cuatro

pasos:

Estimacion de los parametros.
Validacién del modelo.

Prediccidon de valores futuros.

Especificacién del modelo econométrico.

En este capitulo se estudiardn los dos primeros, dejando para el

proximo los restantes. Cada paso se ilustrara con una aplicacion

numérica utilizando los datos de la tabla de datos 15.1, los que

fueron obtenidos de una muestra para las variables Y, X, y X; en 5

observaciones de tiempo.

Tabla 15.1
Observaciones Y, Xat X3t
1 7 4 2
2 10 6 4
3 5 2 1
4 11 5 10
5 20 16 3
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15.2. Especificacion del modelo

Dada la siguiente tabla de datos

Observaciones | Y X, X3 ... X
1 Yi X Xa; X1
2
t Yo o Xa Xy Xkt
T Yr o X Xgr o Xip

Si existe una relacion lineal entre la variable a explicar Y, con k—1

variables independientes X;,j = 2, ..., k se podria especificar:
Yo = B1+ BoXor + -+ BrXpe + & VE=1,2,...,T [1]
En este modelo:

« la variable Y, t=1,2,..,T es la variable enddgena
+ las variables X;,j=2...,k; t=1...,T son las variables
explicativas o exdgenas,

e B=1[B P, .. Bx]' es el vector de coeficientes de regresion,

* &, t=1...T es la perturbacién aleatoria,

« T son las unidades de observacidon temporales o tamafio de

la muestra.
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Es decir, el modelo se podria expresar como un sistema de

ecuaciones, de la siguiente manera

Yy =B+ BoXoy + BaXgy +o B Xy + &
Yo =B+ BXoy + BoXay T+ B Xo +E,
Yo = B+ B X5+ BXgy +o+ BiXs T E; [2]

Yr =B+ BoXor + BXgr +o0+ B X &

Que es un sistema de T ecuaciones con k incognitas, por lo que el

modelo tiene T -k grados de libertad.

Los coeficientes de regresion B;, j=1...,k se suponen constantes

para toda t y recogen el incremento promedio que experimenta la
variable enddégena cuando se produce un incremento unitario en la

j — ésima variable exdgena, permaneciendo las demas constantes.

Esta relacién es lineal en los parametros y se puede escribir en

notacidon matricial:
y =X B *teg [3]
Tx1 TXK  kx1 Tx1

Donde cada uno de los elementos se definen segun:
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[y, | 1 Xz Xz o Xpg B &

Y, 1 Xy Xz 0 Xip B &
y = X = B = € =

YT | 1 Xor Xgr o Xyr | | By | 28

Ejemplo 15.5.a Utilizando la informacién de la tabla 15.1, la

notacion es:
7 [1 4 2 1 &1
[10] |1 6 4] B1 [821
y=|5| x=|1 2 1| B=[ﬁ2] £e=1&
111] 1 5 10 B, &
20! li 16 31 £

Supuestos del Modelo Lineal General

El modelo lineal general tiene dos partes: una se denomina

sistematica y la otra aleatoria. Esto es,

Vo= B1 + B Xoy ++ BXpet & 5 VE=12,..,T
PARTE SISTEMATICA PARTE
ALEATORIA

El modelo explica la variabilidad de la variable dependiente Y

mediante dos componentes:

» La parte sistematica: Xp

+ La parte aleatoria: ¢



592

La parte sistematica del modelo satisface los supuestos basicos de:

1) Linealidad. El comportamiento de la variable dependiente Y
se ajusta a los parametros del modelo de manera lineal para

todas las observaciones, t=1,...,T.

Sea el vector columna x, que contiene las T observaciones
de la variable X,. Este vector representa la k — ésima columna
de la matriz X de orden txk. La primera columna de X

correspondera a una columna de unos, por lo que g, sera el

término constante del modelo. Si se denomina y al vector
columna que contiene las T observaciones, y;,y,,...,y:, de la
variable enddgena Y, € al vector columna que contiene las T
perturbaciones aleatorias, entonces el modelo puede

escribirse como:

y=p01+tXB,+ -+ xPr+ €

Estoes, y=XB +¢

Observacion. Para evitar posibles confusiones hay que distinguir
entre los vectores columna: x; y X;. X, es la k—ésima columna de
X; mientras que, X; es un vector columna que es la traspuesta de
la fila t — ésima (1xk) de X. Por ejemplo, para referirse a una Unica

unidad de observacion se utilizara la ecuacion Y, = x't[i+ &

donde x; es la notacion que representa la ¢t — ésima fila de X,
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2) Variables exdgenas no estocasticas. Las variables explicativas

X, j=2,..,k se consideran fijas en muestra repetidas y, por
lo tanto, la funcién de distribucién de la variable Y -

condicionada a los regresores fijos X- se puede escribir como

fY 1 X,8)=f(Y,B).

3) Rango Completo. ElI rango de la matriz de variables
explicativas es completo por columnas; es decir, r(X) =k <T.
Este supuesto tiene dos implicaciones. Por un lado, no es
posible expresar una columna de la matriz X como una
combinacion lineal del resto de las columnas y, por otro, se

supone que hay mas observaciones que parametros.

Respecto a su parte aleatoria, el modelo lineal general debe

cumplir con los siguientes supuestos:

4) Media Nula. La esperanza matematica de cada una de las

perturbaciones es cero:

E(e)=0, Vt=12,..T [4]
De forma matricial, se puede escribir como:

£ _E(gl)_ 0
£y E(£2) 0
E(e) = E| &5 [=| E(&3)|=|0|=0

£t _E(g.l. )_ 0
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Observacion. Aplicar el operador esperanza matematica a una
matriz o vector, significa que hay que tomar esperanza matematica

de cada uno de los elementos de la matriz o vector en cuestion.

5) La matriz de varianzas y covarianzas del vector de
perturbaciones € es un escalar: V(g) =0?l;. Con este

supuesto se quiere indicar:

5a) Homocedasticidad. La varianza es constante para todas

las perturbaciones,
E(e) =062 Vvt=12,...,T [5]
5b) No autocorrelacion. No existe correlacion entre las
perturbaciones de diferentes periodos,
E(e,e) =0 Vt#s [6]

La homocedasticidad y no autocorrelacién se pueden escribir

en forma matricial de la siguiente manera:

V(e) = ol [7]

6) Normalidad. La distribucién de probabilidad del término de

perturbacién es normal multivariante:

e~N(0,021;) [8]

El conjunto de supuestos 1) a 6) indican que el comportamiento de
la variable Y viene dado por la parte sistematica del modelo y no
queda, en la parte aleatoria, algun patrén aprovechable para

explicar el comportamiento de la variable dependiente.
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Los objetivos, entonces, se centran en hacer inferencia estadistica
sobre el vector B de pardmetros del modelo de regresion y sobre la
varianza de la perturbacion aleatoria ¢? en base a la informacion

que proporciona la muestra disponible:

b(t’ Xog th)’ t =1,2, -, T

Ejemplo 15.5.b La informacion de la tabla 15.1 proporciona una
muestra de 5 observaciones en el tiempo para las variables Y, X, y

X;, que se utilizara para hacer inferencias sobre el vector

paramétrico del modelo.
En este caso dicho vector viene representado por:

w= g oZ]; vi=123

15.3. Estimacion por minimos cuadrados

ordinarios (MCO)

Los parametros desconocidos del modelo vienen dados por el

vector de coeficientes de regresién B y la varianza de |la

Iy 2
perturbacion o; .
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La estimaciodn, de estos parametros, se puede llevar a cabo por dos

métodos

* el método de minimos cuadrados ordinarios

« el método de maxima verosimilitud.

El criterio de estimacién de minimos cuadrados ordinarios (Mco) se

~

basa en elegir aquellos valores B que minimizan la suma del

cuadrado de los errores, la cual se expresa analiticamente por la

siguiente funcion objetivo:

Mﬁin (Y a Xé)I (Y _Xé):Mﬁin %(Yt _él_éz Ko =+ _ék Xy [9]

De las condiciones de primer orden del problema de minimizacion,
se obtiene un sistema de k ecuaciones, denominadas ecuaciones

normales, que se pueden escribir:

T T T
TB *+ B, X Xy TROX Xy T XY
t=1 t=1 t=1
T T, T T
By I Xop By Xy 4B X X X T OE Y Xy, 10
t=1 t=1 t=1 t=1 [ ]
T T T, T
By Z X ¥ By T X X B DX TR Y Xy
t=1 t=1 t=1 t=1
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Ejemplo 15.5.c El siguiente ejemplo ilustra como se obtienen las
ecuaciones normales con los datos de la tabla 15.1. Suponga,

ademas, que interesa estimar el modelo:
Yo = B1 + BoXor + B3Xar + &5 VE=12,..5

Se puede construir la siguiente tabla de calculos auxiliares:

Tabla 15.2.
2 2 ~ ~
X, X3 1Y XY XY X, X5 1 X ) X, Y ezY-Y
1 4 2 7 28 14 8 16 4 |7,233] -0,233
2 6 4 10 60 40 24 36 16 | 9,980 | 0,020
3 2 1 5 10 5 2 4 1 |4,826]| 0,174
4 5 10 11 55 110 50 25 100 |10,986| 0,014
5 16 3 20 320 60 48 256 9 [19,975| 0,025
Z 33 20 | 53 473 229 132 337 | 130 53 0,000

Las ecuaciones normales son:

53 = 5B; + 338, + 2085
473 = 33, + 337B, + 132,
229 = 208, + 132/, + 1305,

Con solucién: j, = 2418523 f, =1.033557 j, = 034

Por lo tanto el modelo estimado resulta ser:

¥, = 2.418523 + 1.033557 X, + 0.34 Xa,

Las ecuaciones normales se pueden obtener a través del algebra

matricial, como:

(XI X) ﬁmco - Xy =0
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Para obtener estas ecuaciones hay que resolver matricialmente el
sistema a minimizar. Para ello, se plantea el siguiente problema de

minimo:

La recta de regresidn debe pasar por el centro de la nube de
puntos. Hay que plantear la minimizacion de las distancias de
esos puntos a la recta. En el plano (R?) esas distancias son
ortogonales a la abscisa —-que representa a la variable
explicativa-; mientras que, en el espacio de tres dimensiones
(R3) esas distancias son ortogonales al plano -formado por
las dos variables explicativas-. En RF las distancias son
ortogonales al hiperplano formado por las k-1 variables
explicativas. Esas distancias se denominaran residuos minimo

cuadraticos ordinarios y se simbolizaran por e,. De esta

forma, e, =Y, -Y, representa la distancia de cada observacion
a la recta de regresién a estimar por y=XB, siendo ésta la

que se obtendra a partir de las estimaciones del vector B.

;
Pero, como e, es una variable desvio, Zet =0; por lo que, el
t=1

problema de minimo a plantear es el de minimizar la suma de

cuadrados de los desvios.

Esto es
T

Min> el
t=1

0, lo que es lo mismo en términos matriciales:

Min (e'e) =(y—9'(y—¥)
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Planteado el problema de minimizacién, se debe resolver

algebraicamente la siguiente relacion:

Min ly - Xﬁ)l (y—Xﬁ)=Mén [y'y—y' XB - (XB)'y +(XB)' XB

[11]
Teniendo en cuenta que y' XB =(XB)'y
Entonces
vy -y XB-(XB)'y +(XB) XB|=y'y —2B X'y +B' X' XB
Por lo tanto, la expresion a minimizar sera
Min(e'e) = Min [y'y—zﬁ X'y+B X' Xf}J [12]

Las condiciones de minimo exigen:

a) condicidon de primer orden, derivar respecto a la variable -en
este caso B-, e igualar a cero.

b) Condicién de segundo orden, obtener la segunda derivada y

demostrar que es positiva.

Para obtener la condicion de primer orden a partir de la expresién
[12], hay que tener en cuenta que B'X'XB es una forma cuadrética;
la cual se define como el producto entre un vector, su traspuesto y
una matriz simétrica, ordenados de manera que su resultado sea

un escalar.
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En este caso, la matriz simétrica X’ X es una matriz de orden kxk, la
que se combina con el vector B de k elementos dando por resultado

un escalar. X' X se denomina matriz de la forma cuadratica.

Algebraicamente

R > T
X X X
AN = iS| kt |- 2]
T T 5, T B
s ok [ ] ZXa B o Z 2%kt | | By
BXXB=|8 By By ~ BT T T 2 0 By
(1xk) S5 ZfeXa a7 lestxkt :
T... T . . T...2 _(@(15
L X I XkXot Z 1 kX3t glxkt
(kxk)
i .. T LT LT ]

T+LBo> Xy + 2> Xy +-o-+ > X
AT+ Ba 2z %ot H A3z Xar + o A Xk
BT Xy + By e B Y Az
X o + X5 + X oy X 000 + X o X
12 ¥t P2 X ot B3k Xorka ke 2 X2tke

o by b Bl T ST 333 X%+t B Y Xk |
4 2 5 1 P Xa+ By X XaXor t B3 X X3 oot B X XaXig

-~ T . T T -~ T
2 Xps ¥ P 2 Xy Xop + Ba 2 Xy Xaw +--+ B 2 X
At P Mk Ak Xa ot A

. . T LT . T
= T+By X Xop 83 2 Xgp +-+ [ T X }+
1P T P2 2 Xot TP 2 X3t k 2 ¥kt

T . T . T L T }

CTLT T o, T T
+ Py By Xor + By X Xgp + B3 X XorXgp + B X XX |+
=1 =1 t=1
2
{ 1,2 X3t +/32t§1X3tX2t +/33t§1><3t +eet By t§1X3t><kt

T T T > L2
wet Bie| BLZ X+ B I Xaxon + By X XaXar + o B 2 X |
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Reagrupando términos
A| 1 - "2 ~ oA T ~ o~ T A A T
B (X X)B =TB] +2'31'82t§1)(2t + 2'81'83t§1)(3t +o+ 2B By tglxkt +
5T o . . T LT
t B 2 Xt Y 2BoPg X XorXa ot 2B X X oKk

LT 5 T
tB3 Z Xa T 2B Z XN

Esta Ultima expresion es un escalar, que puede derivarse

parcialmente con respecto a cada uno de los elementos de B.

El resultado de las derivadas parciales se ordena en forma de
vector columna -aunque también podrian ordenarse en forma de
vector fila-. No obstante, el requisito importante es la consistencia
del tratamiento que debe darse a los vectores y matrices de las
derivadas de la funcidn para que sean de orden apropiado para su

posterior manipulacion.

Entonces, derivando esta expresion respecto de S, los primeros k

términos, respecto de f, los segundos k términos, y asi

siguiendo... el vector de derivadas parciales es

B (xB| ; ] )
) 0By i 2TBy + Zﬁth::lXZt + 2[33tz::1x3t +o 4 2B, tZ::]_th
op" (X' X)B T T o, T T
OB (X' X)B 0B, 2Py Xor ¥2Paz Xor + 2P Xor ke ot A 2 XX
BOXR | ad oc 08 | = 2B T 2B T X xe +2Bak X2 bt 2B, T v
3 . : : : . .
S ona LT LT T T,
6[5;;(—)()[5 I ZBltZ:llxkt +2/32tz::1X2tht +2/33tZ:jlx3txkt +o 42 télxkt
L k




T ;l ;l {
X X cee X
N L
X X Xopg X o+ 20 Xy X

t?l 2t t—Fl 2t t=%_ 2073 2 20kt
=21 2

D Xy 2 Xy Xop 2 X

t=1_3t 2t ?t =

t=1

T

{
cen X X
(1 3kt

T T
> X > Xoe X > Xy Xyp,p ot
=i 3t = 2t73t = 3t "kt

kt

= 2X'XB [13]
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Este resultado responde a la regla general que establece que “la

derivada de una forma cuadratica respecto a cada uno de los

elementos del vector de dicha forma, es igual a dos veces el

producto de la matriz de la forma cuadratica por el vector de la

misma”, en este caso:

B (X' X)B X XB _ 2X' XB

[14] es un vector columna de k elementos.

[14]

De esta forma, la derivada de la expresion [12] es

de'e

Operando algebraicamente se obtiene

ecuaciones normales:

-X'y+X'XB=0

— =-2X'y+2X'XB =0
oB

la expresién para

[15]

las
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En sintesis, resolver la condicién de primer orden en el problema

de minimo da como resultado las ecuaciones normales.

Por otra parte, dado que la matriz X es de rango completo por

columna [r(X)=k<T], existe una solucidon unica al sistema de

ecuaciones normales que es el estimador minimo-cuadratico

ordinario del vector de parametros B:

Bmco = X'X) X'y [16]
Donde
r T T T -1
T -
t
t=1 t=1 t=1
T T T T Tt=1
D DK D Xase ) Ko X
XX)"*t == — p— o ;. X'y= 1 A2t
t=

- e i”
DX D XuKa D KK ) X £,
t=1 t=1 t=1 _

Aunque este es el resultado deseado, a partir del cual se obtienen
los estimadores minimos cuadraticos ordinarios, aun falta
demostrar la condicion de segundo orden del problema de

minimizacioén, esto es:

d%e'e

— =2X'X>0 17
apz [17]

Y esto es asi, debido a que la matriz X'X es definida positiva.
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Si ﬁ (X'X)ﬁ>0 para todo B # 0, se dice que la forma cuadratica es

definida positiva. Una condicién necesaria y suficiente para que la
forma cuadratica sea definida positiva es que la matriz X'X sea
definida positiva, esto sucede cuando los menores principales de
XX

T
T ZXZL“ . =1 =
r Yoo DK ) XaXae| o XX
ZXZf ZXZZt o = B
t=1 t=1

IT|

son todos positivos.

Observacion. La correspondiente condicidn necesaria vy
suficiente para definida negativa es que los menores principales
alternen su signo; de forma que todos los menores principales de
orden impar sean negativos y todos los de orden par sean
positivos. El menor principal de orden k, |X'X| sera positivo si k es
par pero negativo si k es impar. Esto puede expresarse de forma

resumida por la desigualdad

(-D¥IX'X| >0

Las formas cuadraticas, ademas de definidas positivas o

negativas, pueden ser semidefinidas o indefinidas.

Una forma cuadratica serd semidefinida (positiva o negativa)
cuando un menor se anule, aun cuando los menores restantes

cumplan con el signo correspondiente.
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Una forma cuadratica sera indefinida cuando no se cumplan las

condiciones para que sea definida o semidefinida (positiva o
negativa)

Ejemplo 15.5.d Siguiendo con el ejemplo de la tabla 15.1

1 4 271 171

R [1 11 1 ] [1 6 4] [1 11 1 1]|10|
Buco=114 6 2 5 16| |1 2 1 4 6 2 5 16|]5

2 4 1 10 3 [1 5 10] 2 4 1 10 3 l11J

\ 1 16 3l 20

5 -1
= [33 337 132] [473]
20 132 130 229

1 [26386 —1650 —2384] [ 53 ]
= —1650 250 0 473
5 33 20
[33 337 132] —2384 0 596 11229
20 132 130
~ 2.418523
BMCO =11.033557
0.34

El resultado es igual al obtenido al resolver las ecuaciones
normales, en el Ejemplo 15.5.c.

De las ecuaciones normales se derivan, entre otras, las siguientes
dos propiedades de la estimacion minimo - cuadratica ordinaria, la

primera de las cuales se ve directamente en la tabla 15.2 del
Ejemplo 15.5.c:



606

> e =0 [18]
t=1
donde e, =Y, —,B’l - ,5’2 Xop =+ = Bk X\t son los denominados

residuos minimo-cuadratico ordinarios:

;
> X, e =0 j=2 -k [19]

t=1

es decir, los residuos minimo cuadraticos ordinarios, son

ortogonales a todas las variables explicativas del modelo.

Para el caso de k=2, Y, = B; + 5, X, + &, la interpretacién grafica de
la ortogonalidad de los residuos y de las rectas de regresion es la

ilustrada por la Figura 15.1

N\
ﬂ Regresién muestral
Y = B1+ B2 Xoe

Observacién muestral _
Xy, 1) 7

Regresién poblacional
E(Y/X) = By + B2 X5

X21

Figura 15.1. Lineas de regresién poblacional y muestral
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Para demostrar estas propiedades se considera el vector de

residuos minimos cuadraticos ordinarios

e=y-Xp=y=e+Xp [20]

Por [15] —X'y+X'X[§:O, el que puede reexpresarse como

X' X)B =Xy

Reemplazando y por su igual en [20]
(X' X)B = X' (e + XB)

Realizando los productos convenientemente
X'X)B=X"e+(X'X)B [21]

Para que la igualdad en [21] se cumpla, debe ocurrir que X'e=0;

si se desarrolla la expresidn

T

D&
t=1

1 1 1 - 177e,] |+ 0
X1 Xpp Xpg Xor | | €2 Zifxmet 0
t=
(X'€) =] X3 Xz Xag Xgr [Hes | =1 =101=0 [22]

Z X3t €4

t=1

L
zxktet
Lt=1 _
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Como consecuencia de esta propiedad, los residuos del modelo
lineal general tienen media aritmética igual a cero (siempre y
cuando se incluya el término independiente en la ecuacion de
regresion). Esto es debido a que el primer elemento del vector de

orden tx1 es igual a cero, es decir

-
T Zet
Ye =0=e=2 =0
t=1 T

[23]

A su vez, los demas elementos establecen que la correlacion

muestral entre los residuos y cada variable es cero.

Una vez estimados los coeficientes de regresion, B;, la recta de
regresion muestral,

y =XB
permite estimar los valores de la variable enddégena Y, dado los

valores de las variables exdégenas X. Una observacion Y, puede ser

representada como

Y, = By + PoXor + BsXse + -+ + BrXue

Matricialmente
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Donde ¥, es de orden TxI, X, es de orden 1xk, y B es de orden

kx1.
By
- [32
Esto es, Y, =[1 X2t X3t th] [33 [24]
_Bk_

Ejemplo 15.5.e En el ejemplo resulta:

. B
Yo =[1 Xy Xz B,
Bs

¥, = 2.418523 + 1.033557X,, + 0.34X5,

Se obtiene, de esta manera, igual resultado que el obtenido en el

Ejemplo 15.5.c.

15.4 Propiedades de los estimadores
minimo cuadraticos ordinarios

Los estimadores (Mco), B, bajo los supuestos 1) a 6) son lineales,

insesgados y 6ptimos, en el sentido de tener la minima varianza

dentro de la clase de estimadores lineales e insesgados (teorema

de Gauss—Markov).
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Estimador lineal

La linealidad no requiere de demostracion; es evidente, en el
calculo del coeficiente en [16], la relacion lineal que une al vector
de estimadores con la matriz que contiene los valores observados

de las variables.

Estimador insesgado

Para demostrar que el estimador es Insesgado se parte de [16]:

B=(X'X)*X'y

Utilizando [3]

B =(X"X)"IX'(XB +¢)

Realizando los productos pertinentes

B=(X'X)"X'XB+(X'X)'X'e
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En el primer término del segqundo miembro: (X'X)™X'X=I, por lo

que

B=B+(X'X)'Xe

Utilizando el operador esperanza matematica

E(B) =B+ (X' X)X'E(e)

Por [4], E(g) =0 por lo que

E(B) =B [25]

Estimador optimo

Un estimador es Optimo cuando tiene minima varianza. Antes de
demostrar esto, se debe hallar la varianza del estimador; Ia

diferencia entre el estimador y su esperanza matematica es igual a
B-E(B)=B-B=B+(X'X)'X'e-P
La varianza del estimador V(ﬁ) se define

V(B) =E{[B-BI[B-BI'}
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Ahora bien, al demostrar la propiedad de insesgadez, se obtuvo

que

B=B+(X'X)'X¢

De modo que,

B-B=(X'X)'Xe

Entonces:

V(@) = E{(X' X)X €](X X)X s]}

Aplicando las propiedades de matriz traspuesta:

= E[(X' X)X g€’ X(X'X)™]

Introduciendo el operador esperanza matematica

= (X' X)X E (€)X (X'X)™
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Por lo establecido en [7], V(g) = E(¢'e) = ¢21;; al reemplazarlo en la

expresion anterior
= (X' X)X o2l X(X' X)™

2
€

o. es una constante, por lo que premultiplica al resto de la

expresion
= g2(X" X)X L X(X X))

Simplificando en la expresiéon anterior X'I.X(X'X)™", la varianza del

estimador es el producto entre la varianza del término de

perturbacién y la matriz inversa de (X'X)

V(B) = 02X X)™ [26]

Para demostrar que esta varianza es minima, se supone otro

estimador
B* =[(X' X) " X'+P]y [27]

Donde P es cualquier matriz de orden (kxT) que en caso de

anularse hace que B*=p.
Ahora, reemplazando [3] en [27]

B* =[(X' X) ' X'+P](XB +€&) =B + (X' X) " X'e +PXB +Pe



Al tomar esperanza matematica

ER*) =B+ (X'X)"X'E(g) +PXB +PE(g)

Aplicando lo establecido en [4]
E(B*) =B +PXB

Si PX=0

E@") =B

Lo que significa que B* es un estimador insesgado

El calculo de la varianza de B* es
V(@) = E{[B* -BI[B* -BI'}
Donde

B*-B=B+(XX)"X'e+PXB+Pe-P

Manteniendo la restriccion PX =0
B*B=(X'X)"X'e+Pe
Reordenando

B* B =[(X'X)"X'+P]e

614
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Reemplazando B*-B en V(B*), se tiene que
V(B =E{|(x X)X +Pee’ [x(x X)* +P" |
Introduciendo el operador esperanza

V(B*) =[(X'X) "X +P]E (€& )[X(X'X) ™ +P']

Por [7], V(¢) = E(g€') = 6?17

V(B*) =[(X X) " X+P]o .1 [X(X' X)™ +P']

Teniendo en cuenta que o7 es constante y realizando los productos:
V(B*) = Z[(X" X)X X(X' X)™ +PX(X' X) ™ + (X' X) X' P'+PP']

Introduciendo la restriccion PX =0, que da lugar a que X'P'=0, y

operando algebraicamente, la expresion anterior se reduce a:
V(B*) =o[(X'X)™ +PP']
Por lo tanto,

V(B) = a2|(x X)L +PP|> V(@) [28]
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La diferencia entre las varianzas de [3 y B* es PP', lo que hace que

V(B*) > V(B)

A modo de conclusién, en el modelo Y=XB+ ¢ los B pardmetros

desconocidos se reemplazan por los B estimadores minimos

cuadraticos ordinarios y como consecuencia se tiene que:
y=Xp

Donde cada B,-, vj=1,2,..,k es el mejor estimador lineal insesgado y

6ptimo (ELIO) de g;.
Por lo tanto, dado
Yo = B1+ BoXor + - + BrXpe + &

el ELIO de cualquier combinacion lineal de los B parametros es esa

misma combinacién lineal de los B estimadores

El ELIO de E(Y,) €S By + foXor + - + BiXne

Varianza del estimador

La varianza de las perturbaciones o7, se puede estimar mediante

la expresion:
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S? = [29]

Ejemplo 15.5.f El valor de las varianzas de las perturbaciones para

el ejemplo que se esta desarrollando:

[—0.233]
| 0.020 |
[-0.233 0.020 0.174 0.014 0.025] | 0.174 |
, 0.014
g2 %€ _ lo.ozsj
T—k 5-3
62 _ ee B 0.08577 — 0.04289
" T-k 5-3

Este estimador es insesgado bajo los supuestos 1) a 6)

Para conocer la precision con que se estiman los parametros, es
necesario derivar la matriz de varianzas y covarianzas de los

estimadores que, bajo los supuestos habituales, es de la forma
~ ' _1
v(p) = af(x x) [30]

Un estimador insesgado de V(§), se puede obtener sustituyendo en

[30] la varianza de las perturbaciones por su estimador insesgado:

V() = sz(x' x)_1 [31]
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Ejemplo 15.5.g El célculo para los datos de la tabla 15.1 es

5 33 201" 0,8854 —0,0554 —0,08
V(§)=0.04289[33 120 39] =0.04289[—0,0554 0,0084 0 ]
20 39 40 —0,08 0 0,02

1 0,03797  —0,00237 —0,00343
=[-0,00237 —0,00036 0 l

[—0,00343 0 0,00086

‘7(5:1{ Cov(ﬁ:lﬁz) Cov(ﬁ:lﬁ:3)
= COV([iz[iﬂ V(sz)A COU(€233)
[Cov(p3p,) Cov(Psf,) ‘7(33)

Que es la matriz de varianzas y covarianzas de los estimadores

para los datos del ejemplo.

La estimacidén anterior es posible demostrarla a partir de la suma

de cuadrado de los residuos (SCR). Esta suma es un escalar que se

puede calcular a partir de

;
SCR=)¢el =e'e [32]

t=1
Por [20], e:y—Xﬁ
Utilizando el resultado de [16]

e=y-X(X'X)*X'y

Reagrupando términos en torno a'y

e =[l; = X(X'X)X']y

M
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El coeficiente de y se denomina matriz M
e =My

M es una matriz de orden TXT que posee propiedades interesantes
a los efectos de su posterior tratamiento; es idempotente (M2 = M),

es simétrica (M'=M) y MX =0.

Reemplazando y por su igual en [3]

e =My =M(XB +¢) [33]
resolviendo

e =MXB +Mg

Aplicando las propiedades de la matriz M

e =Mg [34]

Por lo que la suma de cuadrados de los errores sera
e'e=¢MMe

Aplicando las propiedades de simetria e idempotencia se obtiene un

escalar,
1 — 1 2
e'e=¢g'M¢

e'e =¢Ms [35]
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Si al escalar definido en [35] se le aplica el operador esperanza

matematica, se obtiene
E(e'e) = E(g' Mg)

si a esta igualdad le aplicamos la traza

E(e'e) = E[tr(g Mg)]

Observacion. Sea A, una matriz de mxm, la traza de A se define
como la suma de los elementos de la diagonal principal

m

tr(A) = z Qjj = a1 + Az + 0+ Amm
i=1

En particular,
tr(I;) =T
La traza de una matriz tiene las siguientes propiedades:
Sean A y B matrices de mxm
tr(kA) = k tr(A)
tr(A+ B) = tr(A) + tr(B)
tr(A") = tr(A)
Si A y B son matrices mxn y nxm, respectivamente, entonces

tr(AB) = tr(BA)

por lo que

E(e'e) = E[tr(Meg )]
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Pero la traza de un escalar es igual al mismo escalar

E(e'e) =trE(Meg )

Pero M depende de X que es no estocastica; es decir, M es una

constante, por lo que

E(e'e) =tr[ME(eg')]

Nuevamente, por [7] V(g) = E(e€') = 6?17
E(e'e) =tr(Ma?l;)
De modo que

E(e'e) = g2trM [36]

Pero la traza de la matriz M es

trM =t ;] —tr[X(X' X)™X']
=tr[1 ] - tr[(X' X)X X]

Esto es asi, ya que trAB =trBA (en este caso A=X y B=(X'X)"X"),

de modo que:

=trll;]-trl, ]=T-k
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Por consiguiente, en [36]

E(e'e)=ogZ(T -k) [37]

De donde se observa inmediatamente que: S?=

estimador insesgado de o?.

Con este ultimo punto se concluye con la tarea de especificar y
estimar un modelo por el método de minimos cuadrados ordinarios,
con todas las propiedades que hacen a esos estimadores lineales,

insesgados y 6ptimos (ELIO).

15.5. Normalidad de 1la perturbacion

aleatoria

Se ha admitido, aunque implicitamente, que los datos con que se
trabaja provienen de muestras finitas. Esto es cierto en la mayoria
de los casos, aunque para sostenerlo son necesarios supuestos
bastante fuertes, tales como regresores no estocasticos vy
distribucién normal de las perturbaciones aleatorias. Vale decir aqui

que, ademas de minimos cuadrados ordinarios existen otros
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métodos para estimar el vector de parametros B. Por ejemplo, se

podria aplicar una regresion por cuantiles (separando los valores
mas altos y mas pequenos de las variables explicativas) o una
regresion ortogonal (minimizando la distancia ortogonal a la recta
de ajuste y no la distancia ortogonal respecto a las variables
explicativas). La cuestion de cudl estimador hay que elegir
normalmente se basa en las propiedades estadisticas de los
candidatos, tales como insesgadez, eficiencia y precisidon. Estos, a
su vez, dependen también de la distribucion que se supone que
producen los datos. Es interesante el hecho de que un buen
nimero de propiedades deseables pueden obtenerse para el

estimador (Mco), incluso sin especificar una distribucién particular

para las perturbaciones aleatorias en la regresidon. Sin embargo, se
admite -a los efectos de ampliar la discusiéon- que Ilas
perturbaciones siguen una distribucion normal. Esto es, se incluye
el supuesto adicional de Normalidad y se incorporan algunas

propiedades asintoticas.

En forma alternativa se podrian calcular los estimadores maximo
verosimiles, de los parametros del modelo; es decir, aquellos que
son mas probables dada la distribucion de los datos muestrales y

su implicacion sobre la funcién de densidad conjunta.

Para facilitar una posterior comprension se introduce a
continuaciéon resultados estadisticos basicos en forma matricial. En
el modelo lineal general € representa un vector columna de T
variables aleatorias, ¢, &,,..., &r. El valor esperado de cada variable

esE(e)t=1,2,..,T.
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Agrupando estos valores esperados en un vector, se obtiene

E(e1)
E(e) = | F (&) [38]
E(er)

La aplicacion del operador E (esperanza) al vector ¢ significa que E

se aplica a cada elemento del vector.

La varianza de ¢, es, por definicion de varianza V(e,) = E[s; — E(g.)]?.

La covarianza entre €, y ¢, €s E(&, &) = E{[e; — E(e.)] * [e5 — E(&5)]}-
Si se define el vector

[E(el — E(el))
£ — E(g) = E(g2 —.E(SZ))

E(ET —.E(ET))

y se toma E{[e—E(¢g)][e—E(e)]'} queda E(eg'), ya que por el

supuesto del modelo E(g) =0

Esto es igual a decir

&1

V(e) = Eee) = E|| 2|1er & -~ e

e,

[0 ] E €1 E(elaz) E(£1£3 E(sls-l-)
€1 €€y €483 - Eq€7 )
€58 s% Exq - EoET E(Ezsl) E(azj E(£2‘°'3 E(£2£T)
=E €381 E3E5 sg €37 - E(s3al) E(s3e:2) E(s%j E(£3£-|-) -
e ertp eres 67 elerey) Elere,) Efres) E(*—%j
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Teniendo en cuenta las definiciones dadas, los elementos de esta
matriz son las varianzas y covarianzas de las variables ¢, la cual se

puede representar como:

V(el) Cov(elez) Cov(eles) Cov(ele_l_)
Cov(ezel) Vv 52) Cov(ezes) -« Cov SZET)
Cov 5351) Cov(esez) V(esj Cov(ese_l_)
_Cov(eTsl) Cov(e_l_sz) Cov(e_l_e3) V(e_l_j |

Las varianzas son los elementos de la diagonal principal y las
covarianzas aquellos que se encuentran fuera de ésta diagonal.

Teniendo en cuenta el supuesto 5 (5.a y 5.b) la matriz es igual a:

[0 O 0] 1 0 0
et
0 0 o2 0 0 1

Esta matriz se conoce como matriz de covarianzas y se simboliza

como

T =V(e) = E(gg’) = o1, [39]

Estd claro que I es simétrica (esto es, £=%'). Ademas, X es
definida positiva ya que todos sus menores principales son
positivos.
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Para que X sea definida positiva las ¢ deben ser linealmente
independientes. Si se define una variable aleatoria escalar Y como

una combinacion lineal de las ¢
Y=[e—E(g)]'c [40]

donde ¢ es un vector columna arbitrario de t elementos no todos

nulos.
Elevando [40] al cuadrado
Y2 =c'[e—E(e)][e—E(e)]'c

esto es, por ser un escalar de argumento vectorial, su cuadrado se

obtiene premultiplicando por su transpuesta.
Aplicando el operador esperanza, se obtiene
E(Y?) = E{c'[e-E(®)][e - E(e)]'c} = ('E{[e — E(e)][e — E(e)]'}c

por ser ¢ un vector de elementos constantes y € un vector de

variables aleatorias, entonces

E(Y?)=c'Zc [41]

Puesto que Y es una variable aleatoria escalar se cumplira que:

E(Y?)20 de esta forma, ¢'=c =0 y Z es semidefinida positiva.

Como se ve, E(Y?) puede asumir un valor nulo o un valor mayor

que cero. Si asume un valor nulo, se tiene E(Y?)=0 lo que implica

que Y =0
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Observacion. La esperanza matematica de una constante s es
igual a la constante s, por lo tanto, la esperanza matematica del

cuadrado de una constante es el mismo cuadrado:
E(s)=s => E(s?)=5s?

Si la constante es 0, la esperanza matematica es 0. De esta

forma:

E(Y?)=0 => Y?=0 por lo tanto, Y=0

Entonces, [e—E(g)]'c=0; pero como ¢ no es un vector nulo la
Unica posibilidad es que [e—E(g)] =0, lo cual significa que las
desviaciones de € con respecto a su media, esto es [g; — E(g;)], [e; —

E(gy)), ..., [er — E(ep)], son linealmente dependientes.

De modo que X es definida positiva si y solo si entre las € no existe

dependencia lineal.

Observacion. Si para un conjunto de parametros A, no todos
nulos, pertenecientes a un campo numérico F tenemos que se
cumple la siguiente combinacion lineal A;a1 + A,a> + ... + A anp
= 0 se dice que los vectores aj, ap,..., ap son linealmente
dependientes dentro de F, salvo que la igualdad se cumpla solo y

solo si todos los A (i=1, 2, ...,n) son iguales a cero. Entonces se

dice que los vectores son LI. Esta definicién se aplica también
cuando el nUumero de vectores es uno, de modo tal que un Unico

vector aq es independiente si a1 #0 y dependiente si a1=0, es

decir, es el vector nulo. En el caso que nosotros analizamos se
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cumple esta ultima condicién ya que cada variable desvio es nula y

conforma un vector nulo: Xx=(x—-p)'=0; esto es,[x1, X2,

v Xnl=[(X1-H1), (X2-H2), ...(Xp-Hn)1=I0, O, ...,0] donde Xx; es la

variable desvio.

Observacion. Dadas t variables aleatorias cualesquiera, con

alguna funcidn de densidad de probabilidad multivariante
p(x) = p(Xy, Xz, ..., X¢)
CONEX)=puy Vi ==X
La funcidon de densidad de probabilidad mas importante es la
normal multivariante que, al igual que la univariante, queda

especificada una vez que se conoce su media y su varianza. En

este caso se puede especificar en términos del vector de medias

My de su matriz de varianzas y covarianzas Z. De este modo la

formula es:

1

1 Ie—1
_ [-3-w'= 7  x-w)]
- (27T)T/2|Z|1/2 et 2 [42]

p(X)

donde:

2 es una matriz simétrica, definida positiva, cuyos elementos o

son parametros

I es un vector tx1, cuyos elementos u, son parametros.

251

Uz
=1

Ut

Una forma compacta de escribir [42] es

X ~N(u; Z)
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es decir, el vector X de variables X, se distribuye segln una ley
normal multivariante con vector de medias R y matriz de

varianzas y covarianzas X.

Casos especiales

a) Cuando t=1,

£ =011 =E[(Xg ~p1)(Xq ~p)I =El(X —p)*] =07 =0°
[43]

y [42] se transforma en

1 2
1 )
pP(X)=——F7-e 7
(277.)1/ 20. [44]

que es la conocida funcién de densidad para una normal

univariante.

b) La forma cuadrdtica de la normal multivariante se define

como

=(x —p)'Z7H(x — ) [45]

Es una forma cuadratica en los elementos X, —u,, Y puede
escribirse asi:

T

ZZ ut)(x i) .

t=1

Como qued6 demostrado la matriz de la forma cuadratica, %,
es definida positiva por lo que la forma cuadratica también lo

es. Un resultado inmediato de esto es que p(x) >0, puesto
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que el determinante de una matriz definida positiva es
positivo, [Z| >0. Esto basta para probar que [42] satisface una
de las propiedades que la califican como funcidon de densidad.
La otra propiedad que deberiamos probar es que [[---[p(x)=1.

Cuestidén que se cumple pero que no demostraremos aqui.

Un caso especialmente importante de [42] se da cuando
todas las X tienen la misma varianza ¢? y no estdn
correlacionadas entre si (lo que es lo mismo decir que son
estadisticamente independientes). Para que esto ocurra Z
debe ser una matriz diagonal, como es el caso de la matriz

de varianzas y covarianzas de la variable ¢

[0 0 - 0]
2
2=0§Ir=[? % ‘3‘ [47]
0 0o - 082

Esta matriz tiene las siguientes particularidades
5| = o2T

1/2 — (;2TV\1/2 — (~2)\T/2
1Z| (0¢7) (0¢)

1
Izt = =1

0-8
con lo que

)= g [48)

La ecuacion [48] se puede factorizar de la siguiente forma:
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p(e) = p(ey, &5, ., 67) = 1_[ - €207

t=1 \(2mo?)2

= p(epp(er) ...p(er) [49]

T 1
{ 1 L le—E(e0)]

de modo que la densidad multivariante es el producto de
cada una de las densidades marginales; es decir, las ¢ se
distribuyen independientemente wunas de otras. Este
resultado es de gran importancia; si los coeficientes de
correlacién entre variables que se distribuyen normalmente
son cero entonces las variables son estadisticamente

independientes.

No se puede generalizar este resultado a cualquier tipo de
distribucidn y debera tenerse presente que las correlaciones

que deben ser cero son las poblacionales y no las muestrales.

Ejemplo 15.6 Dada una matriz de 3x3

011 0 0
B=| 0 o0, 0
0 0 04

Donde:
3 es el niumero de variables
— — — 2
011 = 02 =033 =0

0; =0,0i # j, lo cual indica que el coeficiente de correlacion p; es

cero cuando i # j .
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El determinante es

B|=0"" = |[B|=0,0,0,=0%%%=0"°=0°

La inversa es

1

1 _
B =52

Para el célculo se utilizard el método de la matriz adjunta, por el

cual
a1
B™ == Adj(B)
B]
(a2)? 0 0
Adj(B)=[Cof(B)]’=[—1"+fo;,-'=[ 0 (a8 0 ]=a§1
0 0 (g2

De modo que:

1 1
B_l :—60'21'1 :—21
O¢ O¢

Quedan demostradas las particularidades que tiene la matriz 2,

Recordando la hipdtesis de normalidad en la distribucion de la

perturbacién aleatoria dada en [6]

£~ N(0,07l;)
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Es decir, el vector de perturbaciones aleatorias & tiene una

distribucién normal multivariante, dada por [48], donde:

o?l; es una matriz escalar, definida positiva, cuyos elementos o?

son constantes.

Si se recuerda la definicidn de la distribucion normal multivariante,
se observa que en este caso todas las variables tienen la misma
varianza o® y no estdn correlacionadas entre si (lo que es lo
mismo decir que son estadisticamente independientes). Para que

esto ocurra X debe ser una matriz diagonal, esto es

o, O 0
s=02=| 0 92 0
0 0 Or7

Con las siguientes propiedades

— — — — 2
011 =03 = =07 =0
o; =0,0i#j. Esto ocurre si y solamente si el

coeficiente de correlacién p; es cero cuando ' * 1,

. |z|:0.2T; |Z|1/2:(0_2T)l/2:(0_2)T/2y Z—lziz . con lo que
o

se obtiene la funcion mostrada.

Por tanto, los elementos del vector g, se distribuyen independiente

y conjuntamente segun una ley normal multivariante con vector de

medias 0y matriz de covarianzas o?l; .
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15.6. Criterio de maxima verosimilitud

En general, las propiedades asintéticas del estimador maximo-
verosimil son muy atractivas en casos en los que es imposible
encontrar estimadores con buenas propiedades para muestras
finitas, situacion esta que se produce frecuentemente en la

practica.

Para ello, si se supone que las perturbaciones aleatorias siguen una

distribucién normal multivariante como la expuesta en [48]

f(e) = (2m) "' 2(02) T2 exp[ -

S €' €]
&€

La funcion de verosimilitud, para los valores muestrales,
expresando € =y - XB y denominando ﬁMV al vector de estimadores

maximo verosimiles, es

1
207

L=(2m?)"' % expl[ -

T
Z(yt _X'tB)Z]
t=1

1

L=(2m0?)"'? exp[-
(2ro;) p[ 207

(y = XB) (y = XB)] [50]

Observacion. La transformacion &, =y, —X'tB es posible ya que

el jacobino para cada observacion, aet/ayt es igual a la unidad.

Ante una transformacion de variables se aplica la solucion

estadistica de cambio de variable.



Mediante un cambio de variable se puede resolver, totalmente o
en parte, un buen nimero de problemas importantes en la teoria
estadistica. Los cambios de variables pueden ser simples cambios
de localizacibn o escala o pueden ser transformaciones

ortogonales.
En este caso se tiene una variable aleatoria € con
comportamiento aleatorio conocido, esto es, con densidad f(g)

conocida, y se necesita determinar el comportamiento aleatorio o

la densidad g(y), de una variable aleatoria y cuya relacion con
€ estd dada por una funcion conocida y = ¢@(€). En este caso en

particular, esa funcién es

Yi :XltB"'gt

Se encuentra que

My gee, (6) = [CeXPrat(e)de = eXelom (g)

Asi, la funcidn generatriz de momentos de y se determina en

términos de la funcidon generatriz de momentos de €, y el

problema de los momentos de y queda resuelto.

En el caso que se esta analizando, afortunadamente, se resuelve

en forma sencilla, ya que
E(y) =E(XB+¢€) =XB+E(g) =XB
V(y) =E[(y - XB)(y - XB)' =E(eg') = ol

Que es la formula utilizada en la funcion de verosimilitud.
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Por otra parte, ante un cambio de variable y =¢(€) donde la
funcidon de densidad de € es f(g), la funcion de densidad y se

calcula como:

0¢,
=f(&)J =f(e)—L
a(y) =f(&)a(y)| (5)ay

=1y, —X;B)‘—a(yta;xtp)‘

t

Donde J(Y) es el Jacobino de la transformacion, determinante

definido sobre la matriz de derivadas parciales de€ respectoa y .

En este caso J(Y) =1 y por lo tanto g(Y) = f(g); lo que implica que
la variable enddégena Y estda independiente e idénticamente

distribuida como una normal multivariada, de la siguiente forma:

y~N(XB; oé1r)
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Para maximizar la funcién de verosimilitud con respecto a B, es

necesario maximizar el exponente o minimizar la suma de

cuadrados. Tomando logaritmos se obtiene el logaritmo de la

funcidn de verosimilitud

1
207

(y = XB) (y - XB)

L= - In27-LIn o? -
2 2

Aplicando las condiciones, de primer orden, de maximo respecto

a los parametros desconocidos, se tiene

oinL _ 1

B 207

X' (y-XB)=0

olnL _ -T 1
SHLI ~XB) (y - XB) =0
do? 20?7 207 (y = XB)ly = XB)

€ € €
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Resolviendo el sistema y remplazando los parametros por sus

estimadores, se obtiene
~ ' _l B ~
Buv = (X X) XY =Bmco

. e'e
o5, =—#S?
T

Condiciones de segundo orden

Para ver si se trata de un maximo, se aplican las condiciones de

segundo orden,

0%InL _ X'X %2mL]_ X'X
=- con -E =—0
BB o? BB | o2

€

0%InL _ Xe 92 InL
> =~"— con - E =0
oBdo; o 0Boa?

' 2
€€ T
con -E 97InL = 7 Yyaque E(£5)=Ta£2

Se puede demostrar que la matriz de derivadas segundas

2 2 '
0 InL2 0 InI; —%(X'X) _X_f
oBop'o, oBdo; |_| o o,
0%InL  a8%InL _Xe T _¢€¢

Pac?  3(02)? o;  20; O



Constituyen una forma cuadratica definida negativa,

suficiente para la existencia de un maximo, porque

—jﬂxxym
O¢
e e z
o; o, |__(XX)| T €g| (_Xe >0
X'e T €'e - 0‘2 20’4 0'6 0'4
- 0-4 20-4 - 6 &€ € € €

Por otra parte, la matriz de informacion es

1 1
(B ?(XX) 0
(8)-|7
o; 0 T4
20,

Y su inversa

= 207

r{p] oZ(X'X)™* 0
0

T

638

condicion

Los términos que estan fuera de la diagonal principal son iguales a

cero e indican que B y o? se distribuyen independientemente.

Cabe aclarar que el estimador de maxima verosimilitud tiene

varianza sesgada, pero goza de todas las propiedades asintoticas

deseables. Es consistente, posee normalidad y eficiencia asintética,
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es invariante y su gradiente tiene media nula y varianza igual a la

cota de Cramer - Rao para estimaciones eficientes.

La cota de Cramer - Rao se obtuvo al hacer la inversa de la matriz

de informacion

= 20

2(X'X)t o
'_1(6] g (X' X) .
0 (4

T

Ningun otro estimador con normalidad y consistencia asintética

tiene una matriz de varianzas y covarianzas menor que esta.

Se dijo que los estimadores maximos verosimiles son también
invariantes. Esto significa que el estimador maximo verosimil de

cualquier funcidn continua de B es esta funcion del estimador

maximo verosimil. Es decir, mientras que con el teorema de Gauss
- Markov se afirma que el estimador lineal insesgado mas eficiente
de B es Buco, ahora se tiene un resultado asintéticamente mas

significativo; ya que, el estimador mas eficiente de g(B), donde

g(B) es cualquier conjunto de funciones continuas, es g(fiMV ).

Analisis del sesgo

A pesar de tener una varianza estimada sesgada, ésta solo difiere

de S? por el factor —TK, ya que el estimador de maxima

verosimilitud esta sesgado hacia cero. Esto se observa a

continuacion
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E(Ouy ) = (T_;k)az :(l—gj 2 <g?

k
Pero el factor T desaparece en muestras grandes.

Asimismo, es posible verificar la equivalencia entre ambos
estimadores, aunque sea asintéticamente. A partir de lo analizado,

se sabe que es posible, teniendo en cuenta la inversa de la matriz

de informacion y la E(S?) =02, escribir
TY2(5%, ~0?)0d - N, 20*)

Donde TY?%2, -0?) es una variable que representa

convenientemente la diferencia de medias de los dos estimadores
de la varianza y que, tomando esperanza matematica y varianza

sobre la misma, cuando T - «, la media tiende a cero y la varianza

a 20*. Tomando esperanza matematica,

E[TY (o —0)] =T?E(dyy —0°) =T *[E(d%y ) ~E(d”)] =
k ko? ko?

=TY2[(1-2Yg? =21 =TY?[- —_
(-2 ] [~ 1=

Calculando la varianza de la variable, se tiene

VITY (o =) =(TH*)V (a3 —0°) =T[V(d3 ) -V(a*)] =

4
:T[Za_] =20°
T

Entonces, cuando T - «; TY?(&2, -0°) - N(Ok, 204)
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Definiendo ahora,

Observacion. z; representa una variable centrada y corregida
k . . .
por el sesgo [1—?j y donde se ha utilizado la deduccion anterior

de esperanza matematica para centrarla.

De lo cual se puede deducir que la distribucion limite dez; es,

(1—%)N(Ok ,204)+T52 o?

Pero, (Tkj y sz desaparecen a medida que T - o, por lo que la

distribucién limite de z; también es N(Ok, 204).

Por otra parte, se puede demostrar que centrando

convenientemente la variable S?, se obtiene
z; =TY2(S2 -0?)~N(0, ,20*)

Por lo que la distribucién asintdtica de S? es la misma que la del

estimador de maxima verosimilitud.

El valor de la funcion de verosimilitud

Sustituyendo los valores estimados maximo verosimiles en la
funciéon logaritmica y tomando antilogaritmos, se obtiene el

maximo de la funcion de verosimilitud
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InL(ﬁ,&z):——anH——lnE LI
2 T 2e'e
INL(B,62) =~ In2r-Lin&e_T
2 2 T 2

]

T
2

T -
L(B,0°) = (zm{efj e

T T
L(p.0?) = (27(@) 2(6 ej i
T
I T
L(B,52%) = (277—@) “lee)2
T
L(B,&?) = constante [{e' e)_TE

Donde la constante no depende de ninguno de los parametros del

modelo. La misma depende de las constantes matematicas nye.
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CASOS DE ESTUDIO, PREGUNTAS Y

PROBLEMAS

Caso 15.1: Correlacion de muestras

La siguiente tabla proporciona los valores de las medias y las
desviaciones estandar de dos variables X e Y, y la correlacién de
ellas para cada una de las submuestras. Calcular la correlacion
entre X e Y para la muestra compuesta obtenida juntando las dos
submuestras. éPorqué dicha correlacién es menor que cualquiera

de las correlaciones que pudieran existir en las submuestras?

NUmero de = —
Muestra muestras X Y Sy Sy My
1 600 5 12 2 3 0.6
2 400 7 10 3 4 0.7

Caso 15.2: Estimacion de parametros

Una muestra de 20 observaciones correspondiente al modelo
Y=a+pX+u

en el que las perturbaciones g se hallan distribuidas normal e

independientemente con media cero y varianza constante, ofrece

los siguientes datos:
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ZY=21.9 Z(Y—?)Z = 86.9 Z(X—X)(Y—Y) = 86.9

Zx = 186.2 Z(X ~ %) =2154

a) Estimara y S

b) Calcular sus errores estandar.

Caso 15.3: Consumo de cerveza y mortalidad infantil

Un investigador se muestra interesado en las dos series siguientes,

definidas para el periodo comprendido entre 1935 y 1946.

AR0 35|36 37]38]39] 40| a1]42]43]44]45]46

X, muerte de nifios
menores de 1 afio 60 62 61 55 53 60 63 53 52 48 49 43
(000)

Y, consumo de
cerveza (barriles)

23 23 25 25 26 26 29 30 30 32 33 31

a) Calcular el coeficiente de correlacidén entre X e Y.

b) Ajustar a X (o Y) una tendencia temporal lineal calculando
una regresion MCO de X (o Y) sobre el tiempo t. El
procedimiento requiere elegir un origen y una unidad de
medida para la variable t. Por ejemplo, estableciendo el
origen en la mitad de 1935 y tomando como unidad de
medida un afio, al afio 1942 le correspondera el valor t=7, y

asi sucesivamente para los demas afios. Si el origen se sitla
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a finales de 1940 (principios de 1941) y la unidad de medida

es 6 meses, entonces al afo 1933 le correspondera el valor

t=-7. Demostrar que cualquier tendencia calculada mediante

X, =a+bt no queda afectada por la eleccién del origen vy la

unidad de medida.

c) Suponer que €, Y €, indican los residuos de X e Y respecto

a sus valores tendenciales. Calcular los coeficientes de

correlaciéon entre e,, y e,,. Comparar dicho valor con el

obtenido en el apartado a) y comentar la justificacion de

tales diferencias.

Caso 15.4: Primeros pasos en Eviews

Eviews 6 es un software de la empresa Quantitative Micro Software

(http://www.eviews.com/) orientado al analisis econométrico.

Conjuntamente con STATA, es uno de los paquetes disponibles en
la actualidad mas usados y mas. A diferencia de otros programas
conocidos como SAS o SPSS -que se orientan al analisis estadistico
general- Eviews se especializa en econometria, tanto de series de

tiempo como de corte transversal y datos de panel.

Posee la ventaja de contar con una interface grafica, de modo que
resulta mucho mas intuitivo que otras alternativas; pero también
cuenta con el potencial de un entorno programable para usuarios
avanzados, como son S o R (version freeware de S). Una
alternativa freeware a Eviews es “gretl”, un paquete econométrico

con interface usuario grafica (http://gretl.sourceforge.

net/gretl espanol.html).




En el escritorio de la PC,
seguramente se encuentra un
icono como el de la figura, y
tras abrirlo, una ventana con
fondo grisdceo sin mas
detalles. Se comenzara
utilizando datos de la Tabla

15.1 del Ejemplo 15.5.a.

Creando Workfile.
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[ @) eviews BEX]

File Edit Object View Proc Quick Options Window Help

Mis sitios de
red

‘_"3’

Papelera de
Reciclaje

Icono y ventana inicial de Eviews 6

El archivo base con el cual trabaja este programa es el workfile

(fichero de trabajo) que se crea desde el menu File > New >

workfile... (archivo>nuevo>fichero de trabajo). En primer lugar se

abre la ventana Worfile create donde se debe especificar la

estructura del archivo.

Las opciones disponibles son:

(1) Unstructured / Undated

(Desestructurado / No Fechado) que se utiliza en caso de datos que

no se corresponden con observaciones en el tiempo regulares -los

datos del ejemplo, existentes en tabla 15.1, no se corresponden

Workfile Create

~Workfile structure type - Data range

Iregular Dated and Panel
workfiles may be made from
Unstructured workfiles by later
specifying date and/or other

identifier series. - Names [optional)

IUnstluctuted / Undated j Observations: |5

WF: Icaso10_4
Cancel | Page: Itabla10_1

#3%l| con algun periodo de

(T

tiempo-; (2) Dated -
Regular Frecuency
(Fechado - Frecuencia
Regular) para tabla de
datos donde las unidades

de observacion se

Creacidon de un nuevo archivo

corresponden con
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unidades regulares de tiempo -como anos, trimestres, meses, etc.,
se debe especificar la frecuencia, start date (fecha inicial) y end
date (Fecha final)-; y (3) Balanced Panel (Panel Balanceado)
cuando para cada individuo observado se dispone de series de
tiempo de igual longitud, tal que deben especificarse frecuencia,
fecha inicial, fecha final y numero de cross-section (secciones

cruzadas).

Puesto que en la Tabla 15.1 i :(l2,...,5), en Data Range (Rango de

datos) se indica 5 observaciones. También es posible, aunque no
es necesario, indicar el nombre de archivo en WF y el nombre de

hoja (como en Excel) en Page.

Cargando datos

Para cargar los datos en el archivo creado existen dos maneras
diferentes: (1) importando desde una aplicacion externa, como

puede ser Microsoft® Excel, o (2) tipeando directamente en Eviews.

R n e 5 El primero de los métodos
1 t Y X2 X3 . -
consiste en utilizar wuna
2 1 7 4 2
3 2 10 6 planilla de calculo para
4 3 5 2 1
5 4 11 5 10 cargar los datos que luego
6 5 20 16 3

se guardan con alguna de las
siguientes extensiones: *.x/s
(Excel 97-2003), *,wks

(Lotus), otros

Tabla de Datos en Excel

archivos de texto ASCII como *.txt y *.cvs. Una vez confeccionada

la Tabla 15.1 y guardada con el nombre tablal5_1.xls, hay que
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asegurarse de cerrarla y de que ningun programa la esté

utilizando.

En Eviews, desde el menu File > Import > Read Text-Lotus-Excel
(Archivo > Importar > Leer Texto-Lotus-Excel) se abre el cuadro

de didlogo para encontrar la ubicacion del archivo con la tabla.

Primero, hay que indicarle al programa como estan ubicados los
datos en el archivo. En el caso de la tabla 15.1 las filas son las
observaciones, por lo que se marca la opcion By Observation -
series in columns. En Upper-left data cell, hay que indicar la celda
a partir de la cual comienzan los datos propiamente dichos, o sea
la celda B2, pues la columna A contiene rétulos de observaciones, y
la Fila 1 los rétulos para las variables. En names for series or
number if named in file hay que detallar el nombre de las series de
la tabla o bien, si deseamos que el programa importe los nombres
originales, indicar cuantas variables contiene la tabla. Para este
ejercicio se puede escribir vdep vind1l vind2 para renombrar a Y,

X1, X2 respectivamente.

)

[ Group: GRUPO1 Workfile: CASO10_4::tablal0_1\ o[ @ =)
@j@ Name Freeze | | Default v @[Transpose] (Edit+/- [Smpl+/-]@[53mple]
17
obs VIND1 | VIND2| VDEP| | |
1 2.000000 1.000000 4.000000 A

N

3.000000 3.000000 7.000000
1.000000 5.000000 3.000000
5.000000 1.000000 9.000000

9.000000 2.000000 17.00000

w

m

o

Si se han realizado bien todos los pasos, el workfile deberia
contener cinco observaciones y tres variables: vindl, vind2, vdep;
ademas de reservar el espacio para el vector de coeficientes

estimados (c¢) y la serie de los residuos (resid). Una vez importados
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los datos, es posible verificarlos seleccionado los iconos de las
variables, clickeando con el botdn derecho del mouse y eligiendo

Open > as group.

El segundo método para [ New Object e
incluir datos consiste en Type of object Name for object

. . S d

generar series mediante el b I
Equation

Factor

menu Object > New Object. Graph
Group
ifi LogL
Se debe especificar Type of L0 ector Coef
. . Model
Object: Series y un nombre. Pool
Samie
Una vez generados los objetos San—
eries Link
Series Alpha
se abren en grupo o Spool
SSpace
individualmente, presionando S
able
Edit +/- es posible tipear los Veliep

datos como si fuera un planilla

de calculo normal.

Cuadro de Dialogo Crear Series

Trabajando con los Datos

Los Grupos abiertos pueden guardarse con un nombre para
encontrarlos facilmente después. Basta con seleccionar el botén
Name vy escribir el nombre deseado. Otras herramientas
importantes con las que pueden trabajar dentro de la ventana del
grupo se encuentran en el menu View. Asi en Group Members

obtienen el listado de variables que observan:

Edit series expressions below this line -- ' UpdateGroup'
applies edits to Group.

VIND 1

VIND2

VDEP
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La opcidn Spreadsheet les permite volver a la planilla con los datos.
La opcidn Graph les permite graficar los datos en un gran nimero
de formas diferentes; pueden elegir el tipo de gréafico en la primera
pestafia del cuadro de didlogo y pueden cambiar el aspecto del
grafico en las pestafias restantes. Como ejemplo, dado que los
datos no tienen estructura temporal puede preferirse verlos en
forma de barras y no como curvas; para esto se elige General:
Basic Graph, luego Specific: Bar y, para visualizar las tres series

en un mismo grafico, luego Multiple Series: Single Graph.

Graph Options & [ Group: GRUPO1 Workfile: CASO10_4::tablal0_1\ =1 ON|P]
i | (
Type | Frame [ Axis/Scale [ Legend | Line/Symbol | Fill Area [ BoxPlot | Object ] Template e ecoc abject) (it Erneze) (Sanple Fohess siaalpec
Graph type Details: 20
General: Graph data: [Raw data ']
Basic graph N7 —
Spedific Orientation: [No(mal - obs/time across bottom '] 16
CRmete— Aot [one 7]
Spike
Area Multiple series: [Snngle graph 'J 124
Area Band
Mixed with Lines
Dot Plot
Error Bar
High-Low (Open-Close) 8
Scatter
XY Line
XY Area
XY Bar (X-X-Y triplets)
Pie 44
Distribution
Quantile - Quantile
Boxplot
0- -
1 2 3 4 5
[ vIND1 [ VIND2 [ VDEP
| |

Graficando Series

Otra herramienta importante -que se debe utilizar cuando se
comienza a trabajar con los datos- son las estadisticas descriptivas.
Haciendo View > Descriptive Stats > Common Sample (muestra
comun) el programa genera una tabla con las estadisticas para
cada variable: Media (mean), mediana (median), maximo
(maximum), minimo (minimum), desviacidon estandar (std. Dev.),
asimetria (skewness), el estadistico Kurtosis, Jarque — Bera con su

probabilidad, la suma y la suma de desvios cuadraticos (sum sq.
Dev).
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También pueden efectuar Analisis de Covarianza (Covariance
Analysis), el que les permite visualizar la matriz de covarianzas, la
matriz de correlacidon y asociar a estas la matriz de pruebas t para
hipotesis de covarianza nula o independencia. Otro tipo de pruebas
de hipotesis son los test de igualdad (test equality) para medias,

medianas y varianzas a los que acceden a través del menu View.

Analisis de Regresién

Para realizar una explicacion del comportamiento de la variable

dependiente se especifica el siguiente modelo
Vdep; = 1 + [,Vindl; + [3Vind2; + ¢; viz2..5

El valor de los parametros de la Regresién se obtiene desde el
menU Quick > Estimate Equation, en el cuadro de didlogo se

especifica la estimacion escribiendo
vdep c vind1 vind2

El término c indica que se debe calcular la constante de la
regresion; si hubiera mas variables explicativas, se consignan a
continuacién. En Estimation settings se elige Last Square (Minimos
Cuadrados) y en Sample (muestra) se escribe 1 5, es decir desde
la observaciéon 1° a la 5°. Una vez que se acepta esta configuracién

se obtiene la “Salida” de la Estimacion (Estimation Output).

El primer grupo de elementos de la salida indica la variable a
explicar, el método empleado, la muestra considerada y la cantidad

total de observaciones consideradas; este ultimo dato podria se
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menor que el tamano de muestra pues podrian faltar datos o
establecerse una especificacion del modelo a estimar que

imposibilitara utilizar todas las observaciones.

Equation Estimation C X L Equation: UNTITLED Workfile: CASO10_4::tablal0_1\ o |[@]=]
["specification | options (Print Name | Freeze|
; Dependent Variable: VDEP
Equation spedification Method: Least Squares
Dependent variable followed by list of regressors incduding ARMA Date: 08/13/09 Time: 13:33
and PDL terms, OR an explicit equation like Y=c(1)+c(2)*X. Sample: 15
vdep c vind1 vind2| - Included observations: 5
Variable Coefficient Std. Error t-Statistic Prob.
C 0.010899 0.777017 0.014027 0.9901
- VIND1 1.817439 0.101544 17.89806 0.0031
VIND2 0.299728 0.191900 1.561895 0.2587
Estimation settings R-squared 0.994550 Mean dependentvar 8.000000
Method: |LS - Least Squares (NLS and ARMA) v Adjusted R-squared 0.989101 $S.D. dependentvar 5567764
S.E. of regression 0.581270 Akaike info criterion 2.036506
Sample: 15 = Sum squared resid 0.675749 Schwarz criterion 1.802169
Log likelihood -2.091265 Hannan-Quinn criter. 1.407568
F-statistic 182.5000 Durbin-Watson stat 2161730
Prob(F-statistic) 0.005450
Aceptar Cancelar

Cuadro de Dialogo Estimar ecuacion y Salida de la Regresion.

El segundo grupo contiene la estimacién de los coeficientes, sus

errores estandar y la prueba t con la significatividad

correspondiente.

El tercer grupo de informacion O Equation: UNTITLED Workfile: CASO10_4::tabla10_1\ [o)@)=s
(view][Proc) bject] [Print|Name | Freeze] (Estmate [Forecast][stats Resids|

contiene estadisticos Utiles 2

para evaluar la bondad del

ajuste de la regresion, la ol

significatividad conjunta y la 41 B

calidad de la estimacion en j

cuanto al cumplimiento de los = . . . |

supuestos basicos del modelo — Residual —— Actual — Fited

lineal general.

Griéfico de la Variable, su estimacion y

los errores
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Finalmente, desde esta misma ventana de estimaciéon pueden
plotearse graficos para la variable dependiente, los valores
estimados y los errores de estimacion. Para ello se selecciona el
menu View > Actual, Fitted, Residual > Actual, Fitted, Residual
graph (grafico real, estimado, y de residuos). Desde el mismo
menu View se accede a los test y pruebas de hipotesis sobre el

modelo estimado que se estudiara a lo largo de la materia.

Actividades Propuestas

a) Realice todos los pasos comentados anteriormente para
familiarizarse con el manejo del software.

b) Compare la informacidon de la salida de la estimacién, con los
resultados obtenidos a lo largo del Capitulo 15 en relacién al
ejemplo 15.5.

c) Interprete, con los conocimientos ya aprendidos y los que
recuerda de Inferencia Estadistica, el significado de la
informacion contenida en la salida.

d) Localice en la Salida el estadistico

;
SCR=)¢el =e'e

t=1

e) Repitiendo los pasos explicados en este caso, seleccione un
modelo econdmico con el que haya trabajado tedricamente,
especifique el modelo econométrico, busque los datos vy

estime un modelo de regresidn lineal.
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